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ANSI/ASHRAE Standard 

Building Automation and Control Networks 

BACnet MS/TP  
 Supported version TOP Design Studio V1.4.9.35 or higher  
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Refer to this section to check the data addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “BACnet MS/TP” is as follows. 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

BACnet MS/TP Device 

RS-232C *Note 1) 
3. TOP communication 

setting  
4. Cable table RS-422 

RS-485 

*Note 1) For RS-232C configuration, only 1:1 connection is possible. 

 

■ Connectable configuration 

ㆍ1:1 connection 
 

                      

 

 

ㆍ1:N connection 
 

                          ∙∙∙    

 

 

ㆍN : N connection 
 

     ∙∙∙                        ∙∙∙    
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 

 

 
 

 
 

Settings Contents 

TOP Model Check the display and process of TOP to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “BACnet”. 

PLC Select the external device to be connected to the TOP. 
 

Model Interface Protocol 

BACnet Serial BACnet MS/TP 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP system menu. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project] → [Property] → [TOP Setting] → [HMI Setup] → [Use HMI Setup Check] → [Edit] → [Serial] 

– Set the TOP communication interface in TOP Design Studio. 
 

 
 

 

 

Items TOP External device Remarks 

Signal Level RS-232C 

RS-422/485 

RS-232C 

RS-422/485 
 

Baud Rate 115200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. (COM3 supports only RS-485.) 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [Project] → [Project properties] → [PLC settings > COM1 > PLC1: BACnet] 

– Set the options of the BACnet MS/TP communication driver in TOP Design Studio. 
 

 
* The above settings are examples recommended by the company. 

 

Items Settings Remarks 

Interface Select “Serial”. Refer to “2. External 

device selection”. Protocol Select the communication protocol between the TOP and an external device. 

 

● MS/TP Device Parameters 
 

Items Settings Remarks 

N max_info_frames Set the number of data communication before TOP delivers the token.  

N max_master Enter the largest master node address.  

N retry_token Set the number of token transfer retries.  

T no_token Set the time it takes to judge it as token loss.  

T replry_timeout Set the amount of time to wait for a response to a data request.  

T usage_timeout Set the minimum amount of time when a node must spend a token.  

 

● Device Addressing 
 

Items Settings Remarks 

Network Select the connection configuration of TOP and the external device.  

◼ When Network is Local 

Slave MAC ID Enter the node number of the slave.  

TOP MAC ID Set the node number of TOP.  

◼ When Network is Remote 

Router Address Enter the node number of a router.  

Dst Network Number Enter the number of the network where the slave is located.  

Slave Address Enter the address information of the slave.  

TOP MAC ID Set the node number of TOP.  

Src Network Number Enter the number of the network where TOP is located.  

TOP Address Enter the address information of TOP.  
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 
 

   

(1) Communication interface setting 

■ [Control Panel] → [Serial] 
 

 

Items TOP External device Remarks 

Signal Level RS-232C 

RS-422/485 

RS-232C 

RS-422/485 
 

Baud Rate 115200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. (COM3 supports only RS-485.) 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [Control Panel] → [PLC] 
 

 

Items Settings Remarks 

Interface Select “Serial”. Refer to “2. External 

device selection”. Protocol Select the communication protocol between the TOP and an external device. 
 

● MS/TP Device Parameters 

Items Settings Remarks 

N max_info_frames Set the number of data communication before TOP delivers the token.  

N max_master Enter the largest master node address.  

N retry_token Set the number of token transfer retries.  

T no_token Set the time it takes to judge it as token loss.  

T replry_timeout Set the amount of time to wait for a response to a data request.  

T usage_timeout Set the minimum amount of time when a node must spend a token.  
 

● Device Addressing 

Items Settings Remarks 

Network Select the connection configuration of TOP and the external device.  

◼ When Network is Local 

Slave MAC ID Enter the node number of the slave.  

TOP MAC ID Set the node number of TOP.  

◼ When Network is Remote 

Router Address Enter the node number of a router.  

Dst Network Number Enter the number of the network where the slave is located.  

Slave Address Enter the address information of the slave.  

TOP MAC ID Set the node number of TOP.  

Src Network Number Enter the number of the network where TOP is located.  

TOP Address Enter the address information of TOP.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check that the settings of the connected ports in [Control Panel] → [Serial] are the same as the settings of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel] → [PLC]. 

- Check whether communication is connected or not. 
 

Communication 

diagnostics succeeded 

Communication setting normal 

Error message Communication setting abnormal 

- Check the cable, TOP, and external device settings. (Refer to Communication diagnostics sheet.) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 
 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Cable OK NG 

TOP Version OK NG 

2. External device selection 

3. Communication setting 

Communication port OK NG 

Communication driver and protocol OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU OK NG 

 

Communication port OK NG 

Protocol OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

5. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagrams in this section may differ from the external device vendor’s recommendations.) 
 

■ RS-232C (1:1 connection) 
 

COM1 / COM2 

Cable connection 

BACnet MS/TP Device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1   

 

RD 2 SD 

SD 3 RD 

DTR 4 DTR 

SG 5 SG 

DSR 6 DSR 

RTS 7 RTS 

CTS 8 CTS 

 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 
 

COM1 / COM2 

Cable connection 

BACnet MS/TP Device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA(+) 1  SDA(+)  

 2 SDB(-) 

 3 RDA(+) 

RDB(-) 4 RDB(-) 

SG 5 SG 

SDA(+) 6  

 7 

 8 

SDB(-) 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-485 (1:1 connection) 
 

COM1 / COM2 

Cable connection 

BACnet MS/TP Device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA(+) 1  +  

 2 - 

 3 

 

RDB(-) 4 

SG 5 

SDA(+) 6 

 7 

 8 

SDB(-) 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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■ RS-485 (1:1 connection) 
 

COM3 

Cable connection 

BACnet MS/TP Device 

Pin arrangement 
Signal 

name 

Signal 

name 
 

 

+  SDA(+)  

- SDB(-) 

SG RDA(+) 

 

RDB(-) 

SG 

 

 

■ RS-422  (1:N connection) 
 

TOP Cable connection and signal 

direction 

Device Cable connection and signal 

direction 

Device 

Signal name Signal name Signal name 

RDA(+) 

 

SDA(+) 

 

SDA(+) 

RDB(-) SDB(-) SDB(-) 

SDA(+) RDA(+) RDA(+) 

SDB(-) RDB(-) RDB(-) 

SG SG SG 

 

■ RS-485 (1 : N / N : N connection) 
 

TOP Cable connection and signal 

direction 

Device Cable connection and signal 

direction 

Device 

Signal name Signal name Signal name 

RDA(+)  +  + 

RDB(-) - - 

SDA(+) 

  SDB(-) 

SG 

 

  



 

 External device connection manual for TOP Design Studio 11 / 17 

5. Supported addresses 

Describes how to register data of BACnet devices in TOP Design Studio. 

 

※ Precautions when registering the address 

1. You cannot use “ ` “ in the name of the address. 

2. The description field of the address shows [Object type, Instance number, Property]. 

 

■ How to use Import Address 
 

Step 1. Execute “Import Address” among PLC setting items in TOP Design Studio. 

 

Step 2.After registering the data of the other party’s device, start drawing. 

        (The picture below is an example of registering the current value of the Analog Output object whose instance number is 1 

with the name “Sensor_01”.) 
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■Object and property supported in TOP Design Studio 
 

※  Character String data type supports up to 80 characters. 

   Character String data type supports ANSI X3.4 encoding method. 
 

OBJECT TYPE PROPERTY Remarks 

Analog Input 

(AI) 

ObjectIdentifier  

ObjectName   

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

UpdateInterval  

Units  

MinPresValue  

MaxPresValue  

Resolution  

COVIncrement  

TimeDelay  

NotificationClass  

HighLimit  

LowLimit  

Deadband  

LimitEnable  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Analog Output 

(AO) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

UpdateInterval  

Units  

MinPresValue  

MaxPresValue  

Resolution  

PriorityArray  

RelinquishDefault  

COVIncrement  

TimeDelay  

NotificationClass  

HighLimit  

LowLimit  
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OBJECT TYPE PROPERTY Remarks 

Deadband  

LimitEnable  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Analog Value 

(AV) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

StatusFlags  

EventState  

Reliablity  

OutOfService  

Units  

PriorityArray  

RelinquishDefault  

COVIncrement  

TimeDelay  

NotificationClass  

HighLimit  

LowLimit  

Deadband  

LimitEnable  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Binary Input 

(BI) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

Polarity  

InactiveText  

ActiveText  

ChangeOfStateTime  

ChangeOfStateCount  

TimeOfStateCountReset  

ElapsedActiveTime  

TimeOfActiveTimeReset  

TimeDelay  

NotificationClass  

AlarmValue  

EventEnable  
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OBJECT TYPE PROPERTY Remarks 

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Binary Output 

(BO) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

Polarity  

InactiveText  

ActiveText  

ChangeOfStateTime  

ChangeOfStateCount  

TimeOfStateCountReset  

ElapsedActiveTime  

TimeOfActiveTimeReset  

MinimumOffTime  

MinimumOnTime  

PriorityArray  

RelinquishDefault  

TimeDelay  

NotificationClass  

FeedbackValue  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Binary Value 

(BV) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

StatusFlags  

EventState  

Reliablity  

OutOfService  

InactiveText  

ActiveText  

ChangeOfStateTime  

ChangeOfStateCount   

TimeOfStateCountReset  

ElapsedActiveTime  

TimeOfActiveTimeReset  

MinimumOffTime  

MinimumOnTime  

PriorityArray  
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OBJECT TYPE PROPERTY Remarks 

RelinquishDefault  

TimeDelay  

NotificationClass  

AlarmValue  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Calendar 

(CD) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

DateList  

Command 

(CM) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

InProcess  

AllWritesSuccessful  

Divice 

(DV) 

ObjectIdentifier  

ObjectName  

ObjectType  

SystemStatus  

VendorName  

VendorId  

ModelName  

FirmwareRevision  

ApplicationSoftwareVersion  

ProtocolVersion  

ProtocolRevision  

MaxAPDUlengthAccepted  

SegmentationSupported  

ApduTimeout  

NumberOfAPDUretries  

DataBaseRevision  

MaxSegmentsAccepted  

DaylightSavingsStatus  

ApduSegmentTimeout  

BackupFailureTimeout  

Event Enrollment 

(ER) 

ObjectIdentifier  

ObjectName  

ObjectType  

Description  

EventType  

NotifyType  

EventParameter  

ObjectPropertyReference  

EventState  

EventEnable  

AckedTransitions  

NotificationClass  

Recipient  
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OBJECT TYPE PROPERTY Remarks 

ProcessIdentifier  

Priority  

IssueConfirmedNotification  

File 

(FI) 

ObjectIdentifier  

ObjectName  

ObjectType  

FileType  

FileSize  

Archive  

ReadOnly  

Group 

(GR) 

ObjectIdentifier  

ObjectName  

ObjectType  

Description  

ListOfGoupMembers  

Loop 

(LP) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

Life Safety Point 

(LSP) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

TrackingValue  

EventState  

Reliability  

OutOfService  

Mode  

Silenced  

Life Safety Zone 

(LSZ) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

TrackingValue  

EventState  

Reliability  

OutOfService  

Mode  

Silenced  

Multi State Input 

(MI) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

EventState  

OutOfService  

Reliability  

NumberofStates  

TimeDelay  

NotifyClass  

NotifyType  

ProfileName  
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OBJECT TYPE PROPERTY Remarks 

Multi State Output 

(MO) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

EventState  

OutOfService  

Reliability  

NumberofStates  

TimeDelay  

NotifyClass  

NotifyType  

ProfileName  

Multi State Value 

(MV) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

EventState  

OutOfService  

Reliability  

NumberofStates  

TimeDelay  

NotifyClass  

NotifyType  

ProfileName  

Notification Class 

(NC) 

ObjectIdentifier  

ObjectName  

ObjectType  

NotifyClass  

Program 

(PG) 

ObjectIdentifier  

ObjectName  

ObjectType  

Description  

ProgramState  

ProgramChange  

ReasonForHalt  

DescriptionOfHalt  

ProgramLocation  

InstanceOf  

StatusFlags  

Reliability  

OutOfService  

Schedule 

(SC) 

ObjectIdentifier  

ObjectName  

ObjectType  

PriorityForWriting  

Trend Log 

(TL) 

ObjectIdentifier  

ObjectName  

ObjectType  

Enable  

StopWhenFull  

BufferSize  

RecordCount  

TotalRecordCount  
 


